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Lesson objectives
 To learn how to track time worked on a project

 To learn how to invoice a customer for time worked on a project

 To create project reports for time tracking and learn about other project reports

 To learn how to set up items used to track time worked by owners or partners

 To learn how to pay nonemployees for time worked

Supporting materials
 PowerPoint file: Lesson 14

 Video tutorial: Time and billing

Instructor preparation
 Review this lesson, including the examples, to make sure you’re familiar with the 

material.

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.

To start this lesson

Before you perform the following steps, make sure you have installed the exercise file 
(qblesson.qbb) on your hard disk. See “Installing the exercise file” in the Introduction 
to this guide if you haven’t installed it.

The following steps restore the exercise file to its original state so that the data in the file 
matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Open or Restore Company.

QuickBooks displays the Open Company: Type window.

2 Select “Restore a backup copy (.QBB) and click Next.

3 In the Restore Backup: Method window, select Local Backup and click Next.

4 In the Open window, navigate to your c:\QBtrain directory.

5 Select the qblesson.qbb file, and then click Open.

6 In the “Restore Backup: To Location” window, click Next.

7 Navigate to your c:\QBtrain directory.

8 In the File name field of the Restore To window, type lesson 14 and then click Save.

9 Click OK when you see the message that the file has been successfully restored.
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Tracking time and mileage

QuickBooks provides time tracking for any job. Time tracking lets you keep track of the 
time a person spends on each job (including sick and vacation time and time spent for 
general overhead). The person whose time you track can be an employee, an owner or 
partner, or a subcontractor.

You can use time data to do the following:

 Invoice the customer for the time spent doing a job.

 Provide hours worked on an employee's paycheck, or a check to a nonemployee 
(vendor, owner, or partner).

 Track the cost of employees’ gross pay by job.

 Report on the number of hours worked—by person, by job, or by item.

Turning on time tracking

The following procedure shows how to turn on the time tracking feature, (it is turned on 
already in the exercise file).

To turn on time tracking:
1 From the Edit menu, choose Preferences.

2 Click Time & Expenses in the left panel. Then click the Company Preferences tab.

QuickBooks displays the Time Tracking Preferences window.

3 Make sure Yes is selected as the answer to the question “Do You Track Time?”

4 Click OK to save the preference setting.
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Entering time data

There are four ways to get time data into a company file:

 Enter time directly onto a weekly timesheet or single activity form in QuickBooks.

 Use the Stopwatch in the Time/Enter Single Activity window to time an activity 
while you are performing it.

 Use the QuickBooks Timer program to track time and then import the time directly 
into QuickBooks.

 Download online timesheets using the QuickBooks Time Tracker.1

When you track time with QuickBooks, you have a choice of two forms to enter time: 
Weekly Timesheet or Time/Enter Single Activity window. If you want to enter time for 
multiple jobs or multiple days, then the Weekly Timesheet is the best choice.

A single activity entry shows the time spent by one person doing a single activity for a 
single job on a single date. If you tend to enter a lot of detailed notes about your 
activities, or you prefer to enter time data as you complete an activity, use the 
Time/Enter Single Activity window instead.

1 QuickBooks Time Tracker works with QuickBooks for Windows 2006 or later (Pro, Premier, and 
Enterprise versions), updated to the most current release. Internet access is required. Additional 
fees, terms, and conditions apply.
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For example, an attorney could use a single activity entry to record the time he or she 
just spent on a phone conversation with a client.

Information you enter in the Time/Enter Single Activity window displays in the Weekly 
Timesheet, and vice versa. They’re different views of the same information.

The Timer program is useful when you have employees or subcontractors who need to 
track their time but don’t need or want to run QuickBooks. When time is imported into 
QuickBooks from the Timer application, you view the imported time data on the same 
timesheets you would use if you did the data entry directly into QuickBooks.

If you have employees who don’t have access to a computer or who don’t have access to 
QuickBooks, you can print blank copies of the weekly timesheet for your employees to 
fill out by hand.

To print a blank timesheet:
1 From the Employees menu, choose Enter Time and then choose 

Use Weekly Timesheet.

2 From the Print drop-down menu, choose Print Blank timesheet.

3 In the Print Timesheets window, click Print.
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Recording employee time on a weekly timesheet

In this exercise, you’ll complete a weekly timesheet for Gregg Schneider. Later, you’ll 
learn how to invoice a customer for the time Gregg spent working on their job.

To enter information on a weekly timesheet:
1 On the Home page, click Enter Time, and then click Use Weekly Timesheet.

QuickBooks displays the Weekly Timesheet window.

2 In the Name field, select Gregg O. Schneider from the drop-down list.

QuickBooks tracks the time you enter for this employee and displays it when you are 
ready to pay employees. 

3 Click in the Customer:Job column, and then choose Melton, Johnny:Dental office 
from the drop-down list.

QuickBooks will associate the time that you enter in this window with the office 
repairs being completed for Johnny Melton.

4 In the Service Item column, type Installation.

After you type a few characters, QuickBooks fills in the rest of the item for you. The 
Item list, which contains all the services and goods your business provides, is the 
same list that is available to you on invoice forms and throughout QuickBooks.

Notice that QuickBooks fills in the information in the Payroll Item column for you.

Gregg Schneider is paid by the hour. QuickBooks has his hourly rate stored in the 
Employee Center, on the Payroll Info tab in the Edit Employee window.

Note: If you try to select a payroll item that is not associated with this employee, 
QuickBooks displays a warning message. For example, if you try to select Salary 
as the payroll item for Gregg Schneider, QuickBooks tells you that you do not 
have that type of payroll item set up for the employee. (It still lets you make the 
selection, but it warns you that the Salary is set up with a $0.00 rate.)
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5 Click in the W 16 column for the row in which you entered Johnny Melton’s job.

W stands for Wednesday and 16 for the date, Wednesday, the 16th of December, 
2015. Note that you can change the first day of your workweek in the QuickBooks 
time tracking preferences. (From the Edit menu, choose Preferences, and then click 
Time Tracking.)

6 Type 8 to enter the number of hours worked on Wednesday.

7 In the Th field, type 8.

8 In the F field, type 8, and then press Tab.

As you enter hours for each day, the Total column displays the total hours for the 
week.

Your screen should resemble the figure below.

The Billable column to the right of the Total column tells QuickBooks if the time 
will be transferred onto an invoice. A checkmark in the field indicates that you do 
want to invoice the customer for time worked.

If you do not plan on invoicing the customer for time worked, you can click the 
checkbox to remove the checkmark. 

9 Click Save & Close to record the Weekly Timesheet.

QuickBooks records the time for Gregg Schneider and for Johnny Melton’s dental 
office job.

This time can now be transferred onto an invoice for Johnny Melton’s dental office job 
and to create a paycheck for Gregg Schneider.
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Entering mileage

By tracking your vehicle mileage, you can enter, sort, and print lists of your vehicles and 
the mileage you've driven for work-related tasks. You can use this information for your 
tax deductions and for billing your customers.

You cannot use this feature to reimburse employees or vendors for mileage. Nor can you 
track specific vehicle expenses, such as gas, tolls, etc. with this feature. However, you can 
track these types of expenses by entering bills for them as the expenses are incurred by 
employees.

Note: Intuit recommends that you consult with your tax advisor, accountant, or the 
IRS to determine if you can deduct the costs of operating and maintaining your 
vehicle, and which method you should use.

To record mileage:
1 From the Company menu, choose Enter Vehicle Mileage.

2 In the Vehicle field, select 2002 Ford Truck.

3 In the Start Date field, enter 12/16/2015.

4 In the End Date field, enter 12/16/2015.

5 In the Total Miles field, type 25.

6 In the Customer:Job field, select Melton, Johnny:Dental Office from the 
drop-down list.

7 In the Item field, select Mileage from the drop-down list.

The Enter Vehicle Mileage window should look like the following.

8 Click Save & New.

9 Repeat the steps above to enter 25 miles for the same vehicle and customer:job for 
December 17 and additional miles for December 18.

10 Click Save & Close.
400



                                                                                                
L E S S O N  1 4
Invoicing a customer for time and mileage

QuickBooks provides two methods for invoicing customers for time and mileage:

 Create an invoice and then add charges for time and mileage to it.

 View a list of all unbilled charges for every customer, and select which customers to 
bill. When you select a customer to bill, the outstanding billables—time, expenses, 
mileage, and items—are transferred directly to an invoice.

Creating an invoice with charges for time and mileage

Now you can invoice Johnny Melton for the time Rock Castle Construction’s Employee, 
Gregg Schneider, spent working on the dental office job.

To invoice a customer for time:
1 On the Home page, click Create Invoices.

2 Select Melton, Johnny:Dental office as the customer:job.

3 Click Cancel in the Available Estimates window.

4 In the Date field, type 12/18/2015.

QuickStart Tip
Instead of entering time on a weekly timesheet, you can enter single activities at the time 
they occur. A single activity entry shows the time spent by one person doing a single activ-
ity for a single job on a single date. If you prefer to jot down the details of one day’s work as 
the day progresses, this method might work best for you. For example, an 
attorney could use a single activity entry to record the time he or she just spent on a phone 
conversation with a client.

You can move back and forth between the two time entry forms. If you are viewing a 
single activity entry, you can display that person’s weekly timesheet with a click of the 
mouse. On a weekly timesheet, you can select any hourly entry and view it as a single 
activity entry. The two forms are simply different views of the same data.
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5 Click the Add Time/Costs button.

QuickBooks displays the Choose Billable Time and Costs window.

QuickBooks displays the time information entered on the timesheet for Gregg 
Schneider for the Johnny Melton dental office job.

Note: By default, QuickBooks combines time for activities that have the same service 
item, and lists them as one line item on the invoice. If you prefer to have each 
individual line from the timesheet displayed as a line item on the invoice, click 
the Options button and select “Enter a separate line on the invoice for each 
activity.” In the Options for Transferring Billable Time window, you can also 
select to transfer notes about time activities (in addition to descriptions) onto 
invoices.

6 Click in the Use column (the column with the checkmark) to select each of the lines 
that represents time worked by Gregg Schneider.

QuickBooks places a checkmark in the Use column to the left of each entry to 
indicate it is selected.

7 Click OK.
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8 From the Template drop-down list, select Intuit Service Invoice.

The invoice should resemble the figure below.

9 Keep the invoice open. You’ll use it in the next exercise.
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To invoice a customer for mileage:
1 In the Create Invoices window, click the Add Time/Costs button, and then click the 

Mileage tab.

QuickBooks displays the mileage you entered earlier for this job.

2 Click Select All to select each of the lines that represents the mileage for this job.

3 You want to combine mileage on a single line, so click Options.

4 Select the “Combine activities with the same service items and rate” option.

If you are not using a Premier or Enterprise Solutions edition, this option will not 
reference rates.

5 Click OK.
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6 Click OK to transfer the mileage to the invoice.

The invoice should now look like the following image.

7 Click Save & Close to record the invoice.

Creating an invoice from a list of time and expenses

You can invoice for time and expenses using the procedure described in the previous 
exercise, in which you start by creating an invoice for a customer and then choosing 
which time and expenses for that customer to add to the invoice.

QuickBooks also provides a list of all billable time and expenses by customer and job 
that you can use as the starting point for billing customers.

To display a list of time and expenses for all customers:
1 From the Edit menu, choose Preferences.

2 Click Time & Expenses in the list on the left, and then click the Company tab.
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3 Click to select the “Create invoices from a list of time and expenses” checkbox.

4 Click OK.

When you turn on this preference, QuickBooks adds a new item to the Customers 
menu and a drop-down menu next to the Invoice icon on the Home page. You can 
use either option to open the Invoice for Time & Expenses window.
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To invoice from a list of time and expenses:
1 From the Customers menu, choose Invoice for Time & Expenses.

QuickBooks displays a list of all billable time and expenses for all customers and 
jobs. Note that the amounts are broken down by category: time, expenses, mileage, 
and items.

2 Select Abercrombie, Kristy: Remodel Bathroom.

3 Click Create Invoice to invoice Kristy for all outstanding billable items for this job.
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QuickBooks creates an invoice that includes all billable items for the bathroom 
remodel job for Kristy Abercrombie.

If you wanted to include only some of the items on the invoice, you would select the 
“Let me select specific billables for this Customer: Job” checkbox. This would allow 
you to add items to the invoice from the Choose Billable Time & Costs window as 
you did for Johnny Melton in the previous exercise.

4 From the Template menu, choose Intuit Service Invoice.

5 Click Save & Close.

Note that QuickBooks has removed the bathroom remodel job from the Time & 
Expenses list because there no billable items open for that job.

6 Close the Invoice for Time & Expenses window.
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Displaying project reports for time tracking

QuickBooks provides four reports on time, as described in the following table. You can 
create these reports by choosing Jobs, Time, & Mileage from the Reports menu.

Project report Description

Time by Job 
Summary

Shows hours worked subtotaled first by customer or job and 
then by service item.

Time by Job Detail Lists each time activity (that is, work done by one person for 
a particular customer or job on a specific date), and shows 
whether the work is billed, unbilled, or not billable. The 
report groups and subtotals the activities first by customer 
and job and then by service item.

Time by Name Shows hours worked (or tracked as sick or vacation time), 
subtotaled first by the name of the person who performed 
the work and then by the customer or job the person 
performed the work for.

Time by Item Shows the hours worked, subtotaled first by service item 
and then by customer or job.
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Displaying the time by job report

The time by job summary report summarizes the total hours for each job, and the time 
by job detail report breaks down those summary figures into hours for each service item 
and hours for each customer:job.

To create a time by job report:
1 From the Reports menu, choose Jobs, Time & Mileage.

2 From the submenu, choose Time by Job Summary.

QuickBooks displays the time by job summary report.

3 In the To field, change the date to 12/18/2015 and click Tab.

4 Scroll the report until you see the time worked for the 
Melton, Johnny:Dental office job.

The report shows the 24 hours for Installation work performed by Gregg Schneider.
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Viewing time data in more detail

Like all QuickBooks reports, you can QuickZoom any of the numbers in a report to see 
more detail. Suppose you want to see who worked the 24 hours on installation for 
Johnny Melton. You can point to that number in the report and double-click to get 
more information.

To view time data details:
1 Position your mouse pointer over the 24 hours for Installation on the 

Melton, Johnny:Dental office job, and then double-click.

When you position your mouse pointer over the number, the pointer changes into 
a magnifying glass with a Z in it. After you double-click, QuickBooks displays a time 
by job detail report for the time data you selected. (This functionality is called 
QuickZoom.)

You can see that Gregg Schneider did the work and the time has already been billed 
to the customer.

2 Close the Time by Job Detail report.

When QuickBooks asks if you want to memorize the report, click No.

3 Close the time by job summary report.

When QuickBooks asks if you want to memorize the report, click No.
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Displaying other project reports

In addition to the estimate and time reports, QuickBooks provides several project 
reports to track job profitability, as described in the following table.

Paying nonemployees for time worked

When the company file has time data for a person who is not on your payroll, you can 
write checks based on the time worked. QuickBooks can transfer time data for a 
specified date range to a check. QuickBooks prefills the Items tab of a check with 
information from the time data, including hours worked and rate.

You can pay a subcontractor, owner, or partner for time worked. The person must be on 
one of the following lists:

 Vendor (appropriate for subcontractors, especially if you must report payments to 
them on Form 1099-MISC)

 Other Names (appropriate for owners and partners)

 Employees set up as type “Owner”

To set an owner up on the Employee list, choose Employee Center on the icon bar. 
Edit the employee record. On the Employment Info tab, choose Owner from the 
Type drop-down list. Employees set up as “Owner” do not use payroll.

Note: To pay an ordinary employee for time worked, use the payroll feature to write 
a paycheck.

Project report Description

Job Profitability 
Summary

Compares the actual cost to the actual revenue for all 
customers and jobs. The report subtotals the data first by 
customer and then by job.

Job Profitability Detail 
(for one customer:job)

For a particular customer or job, compares actual costs to 
actual revenues and shows the difference between the two 
amounts. The report subtotals the data first by item type and 
then by item.

Item Profitability For each item, compares the actual cost to actual revenue 
and shows the difference between the two amounts. The 
report subtotals the data first by item type and then by item.
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Creating service items for subcontractors, owners, or partners

When you use service items for subcontractors, QuickBooks records expenses and 
income for the work in separate accounts. You can use such items on both purchase 
forms and sales forms.

In this section, you learn how to do the following:

 Set up a service item to use to track work performed by an owner or partner

 Enter time worked for an owner or partner

 Prepare a check to pay an owner or partner for time worked

To set up a service item for owners or partners:
1 From the Lists menu, choose Item List.

2 Click the Item menu button, and choose New.

3 In the Type field of the New Item window, choose Service from the drop-down list.

4 In the Item Name/Number field, type Planning.

5 Select the “This service is used in assemblies or is performed by a subcontractor, 
owner, or partner” checkbox.

QuickBooks changes the window to display fields for sales and purchase 
information.

6 In the Description on Purchase Transactions field, type Job Planning and press Tab.

QuickBooks copies the text into the Description on Sales Transactions field.

7 In the Cost field, type 50 and press Tab.
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8 From the drop-down list in the Expense Account field, choose the equity 
subaccount called Owner’s Draw.

If you pay owners (or partners) for time worked, you need a service item that records 
the cost of the work as a draw against equity, rather than an expense.

9 In the Sales Price field, type 90.

10 In the Tax Code drop-down list, select Non.

11 In the Income Account field, type Planning and press Tab.

12 When QuickBooks tells you that Planning is not on the Account list, click Set Up.

13 In the Add New Account window, make sure Income is selected in the Type drop-
down list and click Save & Close.

Your screen should now look like this.

14 Click OK to close the New Item window.

15 Press Esc to close the Item list.

In the next section, you learn how to use the Planning item you’ve just created to track 
time performed by the owner of Rock Castle Construction.
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Recording nonemployee time worked

You record data for time worked by nonemployees the same way you enter it for 
employees.

To enter time for nonemployee time worked:
1 From the Employees menu, choose Enter Time. Then choose Time/Enter Single 

Activity.

QuickBooks displays the Time/Enter Single Activity window.

2 In the Name field, choose Tom Ferguson from the drop-down list.

Note: When you selected the owner’s name, QuickBooks removed the Payroll Item 
field from the window. (When class tracking is on, this field is replaced with 
the class field.) Owners and partners should be set up on the Other Names 
list, or on the Employee List with the Type set to “Owner” because they are 
not paid with payroll checks.

3 In the Customer:Job field, choose Abercrombie, Kristy:Family Room.

4 In the Service Item field, select Planning from the drop-down list and press Tab.

5 Type 8 in the Duration field and press Tab.
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Your screen should resemble the following.

6 Click Save & Close.
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Preparing a check to pay for nonemployee time worked

In this section, you’ll learn how to create a check to reimburse an owner for time worked 
on a specific job.

1 On the Home page, click Write Checks.

QuickBooks displays the Write Checks window.

2 Make sure that Checking is selected in the Bank Account field.

3 Click to put a checkmark in the “To be printed” checkbox.

4 In the Pay to the Order of field, choose Tom Ferguson from the drop-down list.

5 Click Yes at the message QuickBooks displays asking if you want this check to pay 
for time worked.

6 Type 12/10/15 in the Start Date field and press Tab.

7 Type 12/16/15 in the End Date field and click OK.
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QuickBooks prefills the Items tab of the check with information from the time data, 
including hours worked and rate.

8 Click Save & Close in the Write Checks window.

Notice that time activity is marked unbillable so that it is not billed twice—as a time 
activity and an item.

When you record the transaction, QuickBooks creates a journal entry. The following 
table shows the journal entry for the check.

Account Title Debit Credit

Checking $400.00

Owner’s Draw $400.00
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